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Chapter 1

Introduction

This chapter introduces you to

¥ SiteViewª data visualization, and
¥ VirtualSiteª data manipulation.

What is SiteView?
SiteView is a computer software tool that helps engineers, 
scientists, and managers visualize environmental 
information.   It combines VirtualSite object-oriented data 
manipulation with features that allow you to integrate, 
analyze, and view environmental data.  SiteView helps you 
visualize and communicate soil, groundwater, air quality, 
water body, and other natural conditions at real-world sites.

What is a VirtualSite?
When you assess a site whether to rank its hazard potential,
to ascertain the feasibility of alternative remediation 
measures, or to map the distributions of air pollutants, you 
build a conceptual model of the site in your mind.  This 
conceptual model describes the site and reflects any 
hypotheses regarding natural or man-made conditions in a 
geographic and geometric rendering.  

As you continue collecting different data, the conceptual 
model changes to reflect these incoming data.  At times, the
model can become unwieldy due to the sheer volume of 
data required for an accurate site assessment.  Often, this 
mental picture blurs because it must be revised so 
frequently.  

The VirtualSite data model computerizes the conceptual 
model of an environmental site in a compelling three-
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dimensional picture or Òvisualization.Ó  The result of this 
computerization is a spatial model which contains all the 
data from the site.  

Part of the power of the VirtualSite data model lies in the 
fact that SiteView treats data as objects.  Objects have 
values for location, contaminant or pollution data, 
stratigraphy, and any other information that characterizes 
the site.  

Most objects are represented by symbols that you can 
handle directly.  For example, you can display a 
stratigraphic profile based on a series of borings simply by 
selecting the symbols for borings with the mouse in any 
view then choosing a command to create a Section Line.

With SiteView, you can 

 integrate data which have been recorded in different 
formats, 

 visualize the site in a variety of ways, 
 manipulate and analyze the site data, and 
 prepare presentations about the site.

Data Integration

Environmental site assessments require data that are 
recorded in a variety of formats.  Just a few of the data you 
collect are survey data, geologic borings, historical 
affidavits, and soil, air, and surface samples.  The data 
come in every form from handwritten boring logs and 
photographs to spreadsheet files and electronically 
transmitted lab data.  The consolidation of these data is a 
large task.  

SiteView helps you integrate data from these different 
sources.  You can take data in spreadsheet or AutoCAD™ 
drawing interchange file format (DXF) and populate a 
VirtualSite.  As more data are collected, you simply repeat 
the import process and the VirtualSite is revised, reflecting 
the new data that have been merged. 

With SiteView, you can combine data collected at different 
times and from disparate sources to form a single, 
consistent picture of the site.  This model is refined as you 
visualize and analyze the VirtualSite data.
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Site Visualization

Although SiteView provides a central, consistent 
representation of  site data, you can view these data in a 
variety of ways.  SiteView views are dynamic snapshots of 
data.

When you first use the system, you can create a terrain 
contour map on which field samples are represented by 
symbols.  You can delve into the details of a site by 
displaying data objectsÕ attribute values, or you can build a
better conceptual picture of the site by displaying different 
views such as analyte contours and color maps, 3D solid 
models, and stratigraphic profiles.

After youÕve displayed a view, you can adjust it to suit your
needs.  For example, you can specify the grid size on which 
plumes are interpolated and the interval between 3D 
contours showing thresholds of pollution concentration.

Presentation

An important part of your job is showing the results of your 
site assessment to colleagues, clients, and the public.  All of
the graphics in SiteView can be printed.  In minutes, you 
can produce maps, profiles, and 3D views suitable for 
presentation..  You can also save all these views to file and 
use them as inserts for reports or slide shows.
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Chapter 2

Getting Started

This chapter introduces the ways you can use SiteView’s 
environmental visualization capabilities to explore your 3D 
spatial data.  In this chapter we describe:

 How to install SiteView,
 The Mudville Airport data shipped with your copy of 

SiteView,
 How to view and move around a 3D site visualization,
 How to select and change the display of objects at the 

site, and
 How to work with multiple views of your data.

Installing SiteView
This section describes how to install SiteView on your 
computer, and the minimum hardware and software 
requirements you need to use SiteView.

Installing SiteView
To install SiteView, first check to see that the hardware and
operating system configuration on the PC on which you 
want to install SiteView is adequate to support the SiteView
application.  

Minimum PC configuration

Your PC should have at least the following hardware and 
operating system configuration,

Hardware: 486 or Pentium PC running at 33MHz or faster
5MB of free space on your hard disk for 

SiteView
20MB of swap space on your hard disk
VGA monitor 

Software: Microsoft Windows 3.1 or higher
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Win 32S enhancement to Windows (provided 
with SiteView)

Installation procedure SiteView is delivered on five 3-1/4 
inch diskettes.  Two of these diskettes contain the SiteView 
application and sample files.  Two contain the Win 32S 
enhancement for Microsoft Windows 3.1 which is required 
to run SiteView's graphics.  The final diskette contains an 
electronic version of the SiteView User's Guide in Microsoft
Word for Windows format.

Before installing SiteView, first install Win 32 S by 
following the instructions on the diskettes.  Next, install 
SiteView.

Intallation of Microsoft Win32S™ 1.15.111.0

1. Start Microsoft Windows

2. Insert Disk 1 of Microsoft Win32S

3. From Program Manager, select File menu, and choose 
Run

4. Type a:\setup and press Enter

5. Follow Directions

Intallation of SiteView™ 1.0

1. Return to DOS prompt c:\
2. Type mkdir siteview and press Enter
3. Type cd\siteview and press Enter
4. Insert Disk 2 of SiteView
5. Type a:pkunzip -d a:siteview and press Enter
6. Follow Directions

Viewing or Printing This Document

1. Start Microsoft WORD™ for Windows or compatible word
processor software
2. Insert DOCUMENTATION DISK
3. Open a:siteview.doc
4. View or Print
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Starting SiteView™ 1.0 from Program manager

1. From Program Manager, select File menu, and choose 
Run

2. Type c:\siteview\sv.exe and press Enter
3. Once in SiteView, select File menu, and choose Open
4. Type c:\siteview\mudville\mudville.sws and select Open

Starting SiteView™ 1.0 from an Icon

1. Start Microsoft Windows
2. From Program Manager, select File menu, and choose 

New
3. Choose Program Group and press OK
4. Complete the fields in the Program Group Properties 

dialog box in the following way:  

Description:  SiteView

5. Press OK.
6. From Program Manager, select File menu, and choose 

New
7. Choose Program Item and press OK
8. Complete the fields in the Program Item Properties 

dialog box in the following way: 
 
Description:  SiteView 1.0
Command Line: C:\siteview\siteview.exe
Working Directory: C:\siteview

9. Select the Change Icon button and choose desired icon.  
Press OK.

10. Double click on the SiteView Icon
11. Once in SiteView, select File menu, and choose Open 
12. Type c:\siteview\mudville\mudville.sws and select 

Open

The Keyboard and Mouse
When using SiteView, you enter information with the 
keyboard and mouse.  The keyboard has standard 
typewriter keys, a number pad, and additional special keys. 

The mouse lets you manipulate things on the computer 
screen.  A pointer appears on the screen to show the 
location of the mouse.  When you move the mouse, the 
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pointer moves.  SiteView supports a two-button mouse, 
which allows you three selection alternatives:  Left (Select),
Control-Left (Adjust Selection), and Right.  When your 
system is installed with a three-button mouse, SiteView 
ignores the middle button.

As you use this manual, youÕll be asked to perform the 
following mouse operations.
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This Means
Press Push the mouse button and hold it down.

Release Let go of a pressed mouse button.

Click on Press and release the left mouse button 
quickly before you move the pointer.

Click-left Press and release the left mouse button 
quickly before you move the pointer.

Control-click-left Press and release the control button 
while pressing the left mouse button 
quickly before you move the pointer.

Click-right Press and release the right mouse button 
quickly before you move the pointer.

Double-click Quickly press and release the mouse 
button twice before moving the pointer.

Move the pointer Slide the mouse with no buttons pressed.

Drag the pointer Slide the mouse with one or more buttons
pressed.

Graphically 
select objects

Move the pointer over the object and 
click-left.  To adjust your selection, move 
the pointer over an object and control-
click-left.  If the object is selected, it 
becomes unselected;  if the object is 
unselected, it becomes selected.

You can also select objects by pressing 
the left mouse button and dragging the 
pointer to create a rectangle around the 
area that youÕd like displayed in the 
window.  Release the button and all the 
objects enclosed by the square are 
selected.  

Display menus 
and choose 
commands

Click-right on a menu to display it.  Click-
left on a command to choose it.  To 
choose a menuÕs default command, 
click-left on the menu.

Mudville Airport
The hypothetical Mudville Airport site is a 500-acre 
regional airport bordered by light industry and residential 
areas.  Approximately 30 borings and monitoring wells lie 
within a 4000-foot radius of the site.  Chemical samples 



Chapter 2:  Getting Started

taken in these wells have been used to characterize the 
extent of groundwater contamination in the environs.  A 
small river lies some distance from the site but is not used 
for public water supply.  

All of the data for the Mudville site are, in fact, real, 
although they have been combined from different projects 
and renamed.  All the data are in the public domain and 
may be used for demonstrations and presentations of 
SiteView’s environmental visualization capabilities. 

Mudville data set

The data set that was shipped with SiteView contains the 
following files:

mudville.sws This is a SiteView workspace of the 
Mudville Airport, into which have 
already been imported the mudville.dxf 
CAD drawings, borings.tsv geotechnical 
boring locations, chem.tsv chemical 
samples taken in the borings, and the 
gwl.tsv groundwater levels.

mudville.dxf CAD drawings of the Mudville Airport 
and surrounding areas saved in 
AutoCAD DXF format (these have 
already been imported into the 
workspace, but are saved in a pointer 
file with the workspace; when you open 
a saved site, SiteView searches for the 
DXF files and automatically re-imports 
them; if you delete or move DXF files, 
SiteView will not be able to reimport 
them).

borings.tsv Tab-separated-value (TSV) ascii file 
containing the original soil borings and 
their locations (already imported into 
the workspace).

chem.tsv TSV file of chemical analyte values 
(already imported into the workspace).

gwl.tsv TSV file of groundwater levels across the
site (already imported into the 
workspace).
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measure.tsv TSV file of chemical measurements.

strat.tsv TSV file of stratigraphic interval 
observations for the monitoring well 
data in the wells.tsv file, consists of well 
name, from-depth, to-depth, and 
material type data (not yet imported).

wells.tsv TSV file of monitoring well names, 
locations, and depths (not imported into 
the workspace yet)

Viewing Mudville

Starting SiteView

To start SiteView:

 Start or login to your computer.
 Start Windows by typing win at the prompt.
 Double-click-left on the icon for SiteView in the Program 

Manager.

Opening the Mudville Site

 From SiteView’s File menu, click on Open.
 In the file browser, double click on the mudville.sws 

file.
 SiteView will open the Mudville site and reconstruct the 

saved view.

Note:  To conserve hard disk space so that you can store 
large amounts of site information, when you save a 
workspace with SiteView only the imported data and 
instructions for recreating the VirtualSite are saved.  When 
you open a site, SiteView recalculates the various surfaces, 
iso-shells, and other objects that have been specified.  
SiteView also recreates the lighting, smoothing, and other 
conditions of the site.  On a typical 486-PC, this rebuilding 
may last for as long as one or two minutes.  Be patient.  
Remind yourself, this is much cheaper than buying a fancy 
graphics workstation.

What’s in the Mudville workspace

When you open the Mudville workspace, you will see that a 
number of objects have already been created.  The idea is 
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that you can use these already created features to explore 
SiteView’s environmental visualization capabilities before 
you need to learn more detailed topics such as how to 
import raw data or how to create iso-shells and surfaces.

The original Mudville workspace contains, among other 
things,

 Planimetric maps of the Mudville Airport and environs, 
lying on top of a 3D bounding box which circumscribes 
the subsurface space.

 A set of borings shown by their locations and 
centerlines.  Along the length of the borings, triangle 
symbols show the locations of chemical samples.

 A 3D groundwater plume of chemical concentrations 
based on downhole samples in the set of borings.

 Groundwater surface.

The various files of data for monitoring wells, stratigraphy, 
and other information about the site will be used later in 
this manual to illustrate importing new data and creating 
new site features.

3D Views
The principal way most people want to view their data is in 
full three dimensions.  In SiteView, this is called the 3D 
view.  When you opened the Mudville workspace, a single 
3D view was present.  You can create a new 3D view of 
your workspace by selecting New 3D View from the 
Window menu.  Within the hardware limits of your 
computer, there is no limitation to the number of 
simultaneous views you can have of your workspace.  

Note:  Because all of the views by necessity share the same
set of colors that Windows supports, usually only the active 
window has the correct colors you have chosen from the 
object properties dialog box.  The inactive views often do 
not keep their correct colors when another window has 
been made active.  For the time being, this is a system 
limitation and there is little SiteView can do about it.



Chapter 2:  Getting Started

Viewpoint

A 3D view allows to see your data in three dimensions.  
Depending on where in space the observer is, this picture 
will appear differently.  You can “look down” on your site 
from above, “look up”  from below, or “look across” from 
some oblique angle.  Also, you can look at the site from 
different azimuth directions.  You control the point in space 
from which you see the workspace by using the Viewpoint...
window which is found under the View menu.  The 
Viewpoint... window allows you to set or increment the 
azimuth, inclination, and perspective of a view.  It allows 
you to move the observation point in to (closer) or out of 
(further away from) the site.

Bounding box

The Bounding Box... command found within the Options... 
window under the View menu allows you to put a box 
around your site.  You can change the color and size of this 
box, and mark its edges with scales.  Most people find it 
easier to perceive three dimensional objects rendered on 
the monitor screen when a bounding box surrounds the 
image.  

The command Fit Bbox Around Selection makes the 
bounding box just circumscribe the selected objects.  If all 
objects are selected, Fit To Selection puts a box around the 
entire site.  If only a few objects are selected, Fit To 
Selection can be used to highlight those objects.

Clip View causes SiteView to trim the image at the faces of 
the box.  This allows you to isolate one part of the site and 
“cut away” everything outside the box which surrounds it.

Rotate

You can rotate the site clockwise away from the observer or
counter-clockwise toward the observer using the up and 
down arrow buttons on the Viewpoint... window.  These 
same buttons appear on the tool bar at the top of the view.  
Each time you click on one of these buttons, SiteView 
rotates the image by the increment shown on the 
Viewpoint... window.  You can change this angular 
increment by typing over the number in the window 
between the arrows.
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Similarly, you can rotate the site to the left or right by 
clicking on the left and right arrows either on the 
Viewpoint... window or on the toolbar.  SiteView rotates the
view by the increment shown on the Viewpoint... window.  

Moving in and out

You can move the viewpoint in toward or out away from the 
site objects using the In/Out buttons.  Moving the viewpoint
in toward the site has the effect of moving the observer 
closer toward the image, and finally inside the set of objects
that make up the workspace.  Moving out has the opposite 
effect.  In/out is the same as “walking through the site,” as 
is often done in architectural graphics.

Note:  Moving the viewpoint in and out is not equivalent to 
zooming-in and zooming-out of  the view.  Zooming 
magnifies the image on the screen ( that is, blows up a part 
of the picture so that all the features are larger); it does not
change the angles of view among the elements of the 
picture.  Moving in or out changes the relative angles of 
different site objects within the view.

Zoom, pan, and scaling to fit

You can zoom in on (magnify) or out of the site display in 
any view.

Zoom

To enlarge (zoom in on) a view:

 Choose the Zoom tool in the window pallet (magnifying 
glass).

 Click-left in the area that youÕd like in the center of the 
display.  The view is redrawn, magnified at 1.2 times the 
original.

 Or, drag-left and pull the pointer to create a rectangle 
around an area.  Release the button and the view is 
redrawn so that the area in the rectangle fills the 
window.  

To reduce (zoom out of) a view:

 Choose the Zoom tool.
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 Control-click-left in the area that youÕd like in the 
center of the display.  The view is redrawn, reduced 1.2 
times the original.

 Or, control-drag-left and pull the pointer to create a 
rectangle around an area.  Release the button and the 
view is redrawn so that the site display is reduced to the 
size of the rectangle.

Pan

You can move the site display in a window using the Pan 
tool or using the Center on Selection command under the 
View menu.  To move the site display with the Pan tool:
 Choose the Pan tool (the hand).
 Drag-left on the desired location; as you drag the mouse,

a line appears.  
 Drag the pointer to a new location, the line is drawn 

from the original to the new location.  
 Release the button and the display moves toward the 

new location.

To center the site display on the current selection:  Choose 
the Center on Selection command from the View menu.

Scaling to fit

You can display the entire site so it all appears in the Plan 
view window.  To resize the site to fill the window:  Choose 
the Scale to Fit All command from the View menu.  The site 
display is resized so it appears in the window completely.

You can display the site so all the currently selected objects
appear in the Plan view window.  To resize the site to 
display all currently selected objects:  Choose the Scale to 
Fit Selection command from the View menu.  The site 
display is resized so the objects appear in the window 
completely.

You can adjust the display of the site in the window by 
zooming in or out on the site, sizing the site to fit the 
window, or moving the site within the window.

Lighting

3D views with iso-shells and surfaces can be lighted to 
enhance the degree of discrimination you perceive in 
visualizing a site.  SiteView can apply a light source at any 
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direction and in any color, and can smooth the reflectance 
of shells and surfaces in a variety of ways.

Light direction

You can set the direction toward which the light source 
strikes the images by clicking on the respective button in 
the lighting window.  Clicking on North means that the light
shines toward the north, and so forth.  The positive y-axis 
points north; the positive x-axis points east.  U, C, and D 
mean that the light shines from the top (upper), center, or 
bottom (down) direction.

Light color

The Light Color selection allow you to change the color of 
the light that illuminates the image.  SiteView provides a 
set of 30 default colors.  You can also select custom colors 
by clicking on Custom at the end of the list.  Colored light 
has little effect when color ramps are turned on, and have 
maximum effect when the color ramps are turned off (i.e., 
index interpolation is turned off) and the surface edge color
is set to a neutral value such as white or light gray.

Lighting algorithm

SiteView provides three lighting algorithms:
 Flat--reflects light at the angle of incidence off each 

planar facet of the surface.
 Gouraud--linearly smoothes the reflectance of the light 

off the facets of the surface.
 Phong--Non-linearly smoothes the reflectance of the light

off the facets of the surface.

Flat lighting calculates faster than Gouraud or Phong 
lighting, but shows the edges of the surface facets more 
readily.  Phone lighting provides the most smoothing, but 
takes the longest to calculate.

Plan views or “maps”

SiteView uses a 3D view of your site data.  To see a plan 
view similar to a standard map or GIS picture, you can set 
the Viewpoint to look down on the site (Top Down View), 
turn off Perspective, and turn off hidden surfaces in the 
View menu, Options... window.  This give you a Planimetric 
map of the site, and also allows you to render 3D iso-shells 
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or surfaces in the same picture.  In the plan view, Send to 
Front and Send to Back change the drawing order of 
objects at the site to enhance the view you want to achieve.

Fence diagrams

A fence diagram is a projected view of stratigraphic panels 
in three-dimensions.  SiteView supports arbitrary fence 
diagrams passing through borings, wells, or other vertical 
sets of stratigraphic data.  Fence diagrams can be cross-
cutting (e.g., a figure-eight section line), multiplicative (i.e.,
more than one sequence of borings), and can intersect iso-
shells.  You can use colors and/or stipples categorized by 
geological material type to represent the different strata in 
a fence diagram, and can make fences opaque or 
transparent to illustrate the attribute levels in an iso-shell 
figure.

To create a Fence Diagram:

 Select the borings or the section line for which you want 
to make a Fence Diagram.

 Choose Create..., Section Line from the Edit menu.

To change the way a fence diagram looks, choose Selection 
Properties... from the Edit menu, and change the properties
of interest.

Working with fence diagrams

A Fence Diagram provides an oblique, three-dimensional 
view of the site.

You can manipulate the Fence Diagram in the same ways 
you manipulate any other 3D view.  For example you can:

 Change the area of the Fence Diagram display by 
zooming in and out, panning, centering on the selection, 
scaling to fit the entire Fence Diagram, or scaling to fit 
the current selection within the Fence Diagram.

 Create annotations within the Fence Diagram.
 Change the appearance of individual site objects 

displayed within the Fence Diagram..
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Working with multiple views

You can create multiple SiteView views and display them 
simultaneously.  For example, you can display different 
parts of a site in two separate views.  You can display a 
plan surface in one 3D view, and examine the same 
attribute with a profile surface in a Fence Diagram, and see
iso-shells in another 3D view all simultaneously.

As before, Windows allows SiteView to use only a single 
color ramp.  Usually, only the active window has the “true” 
colors that you selected.  Inactive windows may have colors
that change when the window is made inactive.  When the 
window is again made active, the “true” colors reappear.  
This is a limitation of the PC hardware and operating 
system and cannot be avoided.
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Chapter 3

Objects and Attributes

Working with objects is the fundamental way of 
manipulating data in SiteView.  This chapter describes how 
objects are organized and used by SiteView; it describes

 objects and object classes,
 attributes and attribute values,
 data types, and
 samples and sources.

Objects and Classes
Objects are organized groups of data values that are the 
basis of all data management, analysis, and visualization in 
SiteView.  Classes organize the data associated with an 
object.  Classes can be thought of as a template for objects. 
The objects themselves are instances of a class, created 
from these templates.   Classes and objects consist of 
groups of attributes which organize the data values.  In an 
object, at least some values for the attributes are filled in.  

The following table gives examples of classes and objects.

Class Objects
Boring B1, B5, B3
Surface terrain, groundwater level
Sample sample SO-4, SO-3, Sample-2

There are two kinds of classes in SiteView:

 default classes in SiteView are defined in the object 
dictionary and can be grouped into subclasses by the 
naming convention you use.  

 derived classes are special classes SiteView creates for 
such things as surfaces, iso-shells, and DXF layers.  
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Some classes have special meaning in SiteView and are 
used to create the various views or new objects of derived 
classes.  SiteView looks for specific attributes in the objects
created from these classes to find the values from which to 
compute views or derived objects.  For example, to create 
Profile views and Fence Diagrams, SiteView looks for the 
material attribute in a stratigraphy sample object which is 
associated with a boring.  

Attributes and Attribute Values
Classes and the objects defined by them contain attributes. 
Attributes hold the objectÕs data values; attributes have 
names and data types.  Attribute names allow you to refer 
to specific attributes.  In an object created from a class 
template, attributes can be filled with data values that 
correspond to their attributeÕs data type.  These values are
called attribute values.

The following table gives a few examples of attributes and 
their data type.

Attribute Data Type/Description
Name String.  
Source References to boring or sample location.
Elevation x Floating point number
Comments String.  Allows users to associate text with

an object.

The following table shows the attributes for the Boring 
Class and the attribute values for a specific boring, named 
B-100.

Class Attributes Attribute Values
Name B-100
X 22620 ft
Y 36280 ft
Z 603 ft

If you created a new boring object, you would specify 
values for the same attributes.

Data Types and Units
Data types determine the valid values for a attribute.  
SiteView supports the following data types:  

 integer
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 floating point
 string

Valid values for strings are any sequence of alphanumeric 
characters.  For integers and floating point numbers valid 
values are numeric quantities.  SiteView does not associate 
units with the data types.  Examples of string, integer, and 
floating point values are shown below.

Data Type Valid Values
String ABCDEF

Cadmium Surface
Boring log

Integer 12345
-37

Floating Point +0.5
+.576
-1.3 e 2

SiteView recognizes not-specified (blank) as a valid value 
for all types.  Not-specified values have meaning during 
data import and are otherwise ignored.  Importing a 
specified value into a attribute which was previously not-
specified overwrites the attribute value; otherwise a conflict
is reported.   Blanks indicate a value is not-specified for 
import. 

Sources, samples, and 
measurements

Objects can be 

¥ sources 
¥ samples, or
¥ measurements.

Sources are the spatially referenced objects or locations 
such as borings at which samples and measurements have 
been taken.  Samples are the spatially referenced objects 
such as a soil sample or groundwater sample which 
observations have been made.  Measurements are the non-
spatially referenced pairs of measurement-type and 
measurement-result which constitute the analytical result 
of sampling.  For example, one related set of source, 
sample, measurement could be:

Source:  Boring B-1, x=1000, y=1521, z=345
Sample:  Water sample at depth 10 feet
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Measurement:  pH, 7.2 

The relationship of source to sample and of sample to 
measurement are parametric ones in which some of the 
sampleÕs attribute values are determined in relationship to
its source, and some of the measurement's attribute values 
are determined in relationship to its sample.  

In the example above, a water sample with a boring as its 
source has an associated pH measurement of 7.2.  The soil 
sample has a "depth" attribute of 10 feet which describes 
its distance down hole relative to the top of the boring.  The
sample also has an elevation attribute Z that is 
parametrically determined from the top of the boring 
elevation and the sample depth:  z (sample) = z (boring) - 
depth (sample) = 345-10 = 245.  The x and y locations of 
the sample are directly inherited from those of the boring.  
The measurement of pH has x, y, and z locations that are 
inherited from those of the sample, so that x=1000, 
y=1521, and z=245.

The connections between sample objects and source objects
and between measurement and sample objects are created 
during import by specifying the name of the source object 
in the sample data or the name of the sample object in the 
measurement data.  If a sample object is imported before 
its source object, or the measurement before the sample 
object, the data will reside within SiteView's data set but 
the object will not be able to be visualized.  Once the source
object is imported, the sample can inherit data from it, and 
consequently be shown in spatial views.  Similarly for the 
sample and measurement.

Water level samples

Water levels are a particular class of sample in SiteView.  
Water level samples have five attributes:  Name, Source, 
Depth, Water Elevation.  The depth is the depth at which 
the measurements was made.  Water Elevation is the 
piezometric potential of the water measurement value, 
expressed as elevation head.  Graphically, water level 
samples show the piezomentric potential as an inverted 
triangle along the boring or well depth.
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Coordinate Systems
Survey data and other site objects specify their position 
with respect to a coordinate system.  SiteView uses a 
reference coordinate system that it constructs from the xyz 
values of objects you import or create.  The data you import
or manually enter into SiteView must have consistent 
coordinate values.  SiteView is not a cartographic system 
and does not internally support coordinate transformation.  
However, objects in SiteView can be translated, scaled, and
rotated with the pallet tools and mouse.
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Chapter 4

Creating, Importing, and 
Viewing Objects

You can create, edit, and delete objects using commands 
from the File and Edit menus.  This chapter describes how 
to

 create new objects by importing data from spreadsheets,
 delete objects already in the VirtualSite,
 import CAD layers from DXF files, 
 create derived objects, and 
 move objects.

Creating objects
There are several ways of creating objects in SiteView.  You
can

 create points, polylines, squares, and polygons with the 
palette tools, 

 import objects from a spreadsheet,
 create derived objects using the CreateÉ commands, and
 import layers from a DXF file.

This section describes how to create and import basic 
objects. Later chapters describe how to create derived 
objects, and how to import stratigraphic data.

Creating objects with palette tools
You can create points, surface points, polylines, and 
polygons using the Palette tools.

Creating points

To create a point:
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1. Click on the Point tool along the left hand side of any 
view.

2. Click on a location in the view, and a point  is created.

Note, SiteView attempts to interpret all three x,y, and z 
coordinates of the point.  However, because any spot on the
2D monitor window corresponds to an infinite number of 
collinear points in the 3D VirtualSite, SiteView needs to 
make assumptions about where the new point is to be 
located.  It does so by fitting a plane perpendicular to the 
line of view at the mid-point of the current selection, and 
placing the newly defined point on that plane.  This may not
be the point in xyz space that you have in mind.  SiteView 
shows the point coordinates in the selection box at the top 
of the view.  If these coordinates are not what you want, 
you can move the newly created point using the Move tool.

Creating polylines, polygons, and squares

To create a polyline or polygon:

 Click on the Polygon tool.
 Click-left on the appropriate locations in the diagram to 

create vertices.  You can click-right to remove the last 
vertex.

 Control-click-left, or close the polygon, to finish drawing 
the object. 

Again, the note above applies to the xyz coordinates that 
SiteView interprets from your graphical input.

Creating Derived Objects
SiteView creates three types of geometric objects that it 
derives from other objects and attribute data:

¥ Iso-Shells of 3D data fields in xyz,
 Attribute surfaces over x,y space, and
¥ Section lines for fence diagrams.

Objects of each of these classes are based on other data in 
the VirtualSite, and they may not be imported.  

Iso-shells of 3D data fields are mathematical 
representations of the relationships between a chosen 
attribute value and the xyz locations of those values in 
space.  An iso-shell is the locus of points of constant 
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attribute value in 3D space.  Examples of iso-shells are the 
threshold value of a groundwater contaminant plume 
having come from downhole samples, or a specified value of
pollutant concentration in the air having come from the 
results of an air dispersion calculation.  Details on creating 
iso-shells are found in the chapter entitled, ÒIso-Shells.Ó

Surfaces are mathematical representations of the 
relationship between a chosen attribute value and the x,y 
locations of those values in space.  Examples of surfaces 
are terrain elevation, depth to groundwater, and 
concentration of some chemical contaminant on the ground 
surface.  Details on creating surfaces are found in the 
chapter entitled, ÒSurfaces.Ó

Section lines are the polylines on the ground surface 
connecting borings that are used in constructing a geologic 
profile or fence (i.e., traverse lines).  A section line shows 
the cutting (poly-)plane used to display geology in a fence 
diagram.  Details on section lines are found in the chapter 
entitled, ÒStratigraphy.Ó

Deleting Objects
To delete an object or group of objects:

 Make sure the object or group is the first element on the 
stack.

 Choose the Delete command from the Edit menu.  A 
dialog box appears asking you to confirm the Delete 
operation.

 Choose the Yes button to delete the object or group.

Note:  Deleting an object is permanent.  You may not 
undelete once the operation has been executed.  If you only 
want to hide an object from view but not delete it, select 
the object or group in question and choose Hide from the 
Edit menu.

Moving Objects
You can move or adjust the location or scale of objects in 
the VirtualSite using a set of pallet tools.  These include the
move tool, horizontal scale tool, vertical scale tool, and 
rotation tool.
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Move tool

You can move selected objects on the Plan view with the 
Move tool.  To move an object:

1. Click on the Move tool.
2. Select an object by clicking left on it.
3. Drag-right the object to the new location.

The next time you select that object, its location 
coordinates will reflect the move.

Horizontal scale tool

The Horizontal scale selection tool allows you to change the
horizontal scale of an object or group.  Clicking-left on the 
object selects, control-left adjusts the selection, and 
dragging-right changes the horizontal (xy) scale of the 
object.  Dragging to the left makes the horizontal extent of 
the object smaller, dragging to the right makes the 
horizontal extent larger.

The Restore Position command under the Edit menu allows 
you to restore the original scale and position if no other 
action has been executed since the change scale.

Vertical scale tool

The Vertical scale selection tool allows you to change the 
vertical scale of an object or group.  Clicking-left on the 
object selects, control-left adjusts the selection, and 
dragging-right in the up/down direction changes the 
vertical scale of the object.  Dragging toward the top makes
the vertical exaggeration of the object larger, dragging 
toward the bottom makes the vertical exaggeration smaller.

The Restore Position command under the Edit menu allows 
you to restore the original scale and position.

Rotation tool

The Rotation tool allows you to rotate the angular position 
of a selected object or group.  Clicking-left on the object 
selects, control-left adjusts the selection, and dragging-
right changes the angular position of the object.  Dragging 
to the left rotates the object counter-clockwise, dragging to 
the right rotates the object clockwise.
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The Restore Position command under the Edit menu allows 
you to restore the original scale and position.

Importing from a spreadsheet
SiteView allows you to integrate different types of data 
from various sources into a single VirtualSite.  You can 
import site data from spreadsheets, databases, or other 
applications by storing your data in a tab-separated-value 
(.tsv) array file.  The order in which attributes appear in the
array is unimportant.  SiteView allows you to map the 
relationship between incoming data columns or rows and 
corresponding SiteView objects or attributes. 

After importing, the data become VirtualSite objects.  You 
can then use SiteViewÕs features to manipulate, analyze, 
and visualize your site data.

The data you import from spreadsheets describes site 
objects and their attribute values.    For example, the 
following spreadsheet data describe three monitoring wells 
in the VirtualSite:  MW-3, MW-3A, and MW-4.

Monitoring Wells
X Y Z Name
7850 10200 233.03 MW-3
7530 10350 193.18 MW-3A
7300 10275 190.29 MW-4

For each object you import from the spreadsheet, SiteView 
creates a temporary object, then searches the VirtualSite 
for a previously existing object with the same name.  If 
SiteView finds such an object, it merges the newly imported
attribute values into the existing object's attribute values.  
If SiteView does not find such an existing object, it creates 
a new object using the attribute values (including the value 
of the Name attribute) you provided on the spreadsheet.

Not:  You need not include the Name attribute for all site 
objects imported from the spreadsheet.  SiteView checks 
for an existing object only if you do provide a name for the 
incoming object.

When you import one or more samples from the 
spreadsheet, you can include for each sample the name of 
the associated source object, thereby establishing the 
relationship between the imported sample and its source.  
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(Recall that each source can have many samples, but that 
each sample has at most one source.)

For example, the following spreadsheet data are chemistry 
samples related to the three monitoring wells.

Sample Source Depth

A B-1  10

B B-1  20

The following spreadsheet data are the analyte 
measurements made in the three chemistry samples.

Measurement Sample Value
METHYLENE CHLORIDE A  6000
TRANS-1, 2-DICHLOROETHENE A  6500
TRICHLOROETHENE A 20000
TETRACHLOROETHENE A  3000
METHYLENE CHLORIDE B  6521
TRANS-1, 2-DICHLOROETHENE B  6043
TRICHLOROETHENE B `9034
TETRACHLOROETHENE B  2300
METHYLENE CHLORIDE C  6100
TRANS-1, 2-DICHLOROETHENE C  6498
TRICHLOROETHENE C 21657
TETRACHLOROETHENE C  3000

You should arrange the data on your spreadsheet so that 
each row or column of an imported range represents a 
single site object.  Within such a row or column, individual 
cells represent values for the objects' attributes.

Preparing Data for Import

Before importing spreadsheet data into SiteView, you 
should prepare your data according to the following 
guidelines:

 Group data of similar class together.  For example, keep 
monitoring wells together on the spreadsheet.

 Remember that objects with no associated x-, y-, and z-
coordinate data do not appear in views.

 Store your data in an ASCII file that is tab delimited 
(.tsv). 
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 Make sure that your data use the same coordinate 
system as the virtual site into which they are being 
imported.

Importing Data

The Import process has the following steps:

1. Specify the .tsv file to import.
2. Specify the import format (columns or rows).
3. Specify the class of object to import in the scrolling list.
4. Map the data layout to the list of attributes.
5. Select ranges of rows to be imported.
6. Click OK or Apply.

Specifying the File

To begin the import process, choose the ImportÉ  Import 
Spreadsheet command from the File menu.  The Import 
Spreadsheet dialog box appears when you first choose the 
Import SpreadsheetÉ command.  It allows you to specify the
name of the spreadsheet file.  

There are two ways of specifying a file in this dialog box:  

¥ Type the file path in the File Name field.
¥ Click on a file in the scrolling list.

After you specify the file name and click on the OK button, 
the Import Spreadsheet dialog box appears with the data 
from the file to be imported.  

Specifying the Class of Object

To specify the class of object to import, click on it in the 
pull-down list of object classes.  The list beneath displays 
the classÕ attributes and changes according to the object 
class you select.  Note that the class list excludes derived 
classes such as surfaces, iso-shells, and section lines 
because you cannot import derived objects.

Describing the Spreadsheet's Layout

Next, you need to describe the spreadsheet's layout to 
SiteView.  That is, tell SiteView which attributes you are 
importing and where on the spreadsheet the values of those
attributes are located.
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Along the top of the data table is a set of blank fields.  Each 
blank field corresponds to a column of data in the table.  In 
each blank field, one of the attribute names listed in the 
scrolling list will be mapped.  This tells SiteView that the 
data in that column correspond to whatever attribute name 
is mapped there.

To make the mapping, select the appropriate blank field 
above a column.  Click on the corresponding attribute in the
scrolling list to the left.  That attribute name will appear in 
the blank field, and the selection will move to the right.  If 
you want to pass over a column, click on Skip Column.  

When you have finished mapping the attributes to data 
columns, highlight the rows of data that you want to import.
Then click OK or Apply and the data will be imported, and 
new objects will be created in SiteView.

Note:  Unmapped rows or columns are not imported.

Importing from a DXF File
You can import two- and three-dimensional DXF layers as 
SiteView graphic overlay objects.  Graphic objects are 
represented as overlays on the 3D view; they do not have 
attributes.  SiteView can import the following DXF entity 
types:

 points,
 lines,
 polylines,
 arcs,
 circles,
 3-dimensional objects,
 solid (entity),
 blocks/inserts, and
 text (with scale and rotation)

SiteView's import capability does not include the following:

 binary DXF files,
 shape (entity),
 trace (entity),
 extended entity data,
 line attributes (e.g., width, style), and
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Because each DXF layer is imported as a static graphic 
object, the contents of an imported layer cannot be edited 
or converted to SiteView objects. To ensure maximum 
performance of SiteView, import as few layers as possible, 
or hide layers that do not need to be visible all the time. To 
make this as easy as possible, group in one layer all entities
that you want to hide or reveal as a unit.

To import DXF files:

1. Choose the Import DXF command from the Import... 
command under the File menu.  The Import DXF dialog 
box appears.

2. Specify the path and file name of the DXF file in the 
Import DXF dialog box and click on the OK button.  The 
Import DXF Layers dialog box appears.  

3. Choose layers from the scrolling list.  
4. Click on the OK button.  SiteView imports the layers as 

editable graphic objects.
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Chapter 5

Selecting Objects

Many SiteView operations require single objects, groups of 
objects, or attribute values as functional arguments.  When 
SiteView operations require this input, SiteView gets the 
input from whatever is currently selected.  The current 
selection and selection history is a scratch pad for 
arguments-to and results-from operations.

When you perform an operation that requires input from 
the selection history, the first element is used.  Some 
operations require more than one input in which case the 
first, second, third, and so on elements are used.

Operations that require input remove the elements 
(arguments) from the selection history and place the 
operation results as the finalÑmost recentÑelement(s) in 
the history.  For example, suppose that the selection history
contained the elements on the left, below, with a group of 
20 groundwater elevation points as the last selection.  You 
can ask SiteView to create a groundwater elevation surface 
from the 20 points by choosing Create... Surface from the 
Edit menu.  After doing so, the selection history would 
contain the elements on the right.

List order Selection history: Selection history:

-4 Object 1 (1)
-3 Object 1 (1) Object 2 (1)
-2 Object 2 (1) Object 3 (1)
-1 Object 3 (1) Points (20)
0 Points (20) Surface (1)

This chapter describes how to,

 select objects,
 manipulate groups of objects, 
 work with the selection history,
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 store objects and groups in registers, and
 query for attribute values.

Select objects
You can select objects by 

 graphically selecting in views, 
 using the SelectÉ window under the Edit menu,
 or using the Selection HistoryÉ window under the 

Select... window.

Selecting objects graphically

You can select objects graphically in any view.  To select 
objects, move the pointer over the object and click-left.  You
can also select objects by pressing the left mouse button 
and dragging the pointer to create a rectangle to surround 
the objects, then release the button and all the objects 
enclosed by the rectangle are selected.  

To adjust a selection, move the pointer over an object and 
control-click-left.  If the object is selected, it becomes 
unselected;  if the object is unselected, it becomes selected.
If you already had selected other objects, control-click-left 
adds or removes the new object from the group.

SelectÉ window

The SelectÉ window is found under the Edit menu.  The 
SelectÉ dialog window has three boxes within it:  a Choose 
From box at the top, a list of object classes along the left, 
and a list of individual objects along the right.  What you 
choose in each of these boxes affects what appears in the 
other boxes. 

Select by class

In the Choose From box you can choose either from

¥ All, or 
¥ Current Selection.  

All, means that you are selecting from the entire 
VirtualSite, and all of the objects and data that have been 
imported or entered into the site.  Current Selection, means
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that you are selecting only from those objects that occupy 
the current selection.

When you choose All, a scrolling list of all object classes 
that exist in the entire VirtualSite appears in the object list 
on the left hand side.  The respective number of objects of 
each class is shown in parentheses next to the class name.  
When you choose Current Selection, the object list contains 
only those object classes and numbers that exist in the then
current selection.  You can toggle back and forth between 
All and Current Selection, and the left hand side list will 
change.

Clicking on one of the object classes in the left hand side 
list, and then clicking on OK or on Apply, tells SiteView to 
select all the objects that are of the class you have just 
highlighted.  You may aggregate different types of objects 
by adjusting the selection (using control-click-left with the 
mouse) in the left hand side.  Clicking on OK or Apply tells 
SiteView to select the group of all objects of all the classes 
that were simultaneously highlighted in the left hand side 
list.

When you highlight a class of object in the left hand side 
list, all the individual instances of that object class(es) 
appear in the scrolling list to the right.  Toggling between 
All and Current Selection in the Choose From box causes 
the list of individual instances of objects in the right hand 
side list to change.  When you highlight individual objects in
the right hand side list, and then click on OK or Apply, 
SiteView selects the group of individual objects that you 
have highlighted.

Select by value

You can also select objects by the values of attributes 
associated with them.  Beneath the scrolling list of object 
classes and object instances is a query bar entitled, 
“Where,” that allows you to select an attribute to query on 
and to set a logical query relationship.  Clicking Filter 
causes this query to be executed on whatever set of objects 
has been chosen in the select class or object scrolling lists.

For example, say that you have selected all measurement 
objects in the scrolling list at the top of the Selection 
window.  Now set the query attribute to "Name," the logical
relation to "=," and the value to "TCE."  SiteView will find 
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all of the measurements of TCE within the group you have 
selected.  Now setting the query attribute to "value," the 
logical relation to ">," and the value to "100," and SiteView 
will find the subset of all TCE measurements for which the 
measured value is greater that 100.  In this way you can 
sequentially query the data in the VirtualSite to find only 
those objects that you want to analyze or visualize.

Selection HistoryÉ
The Selection HistoryÉ button under the Select... window 
displays an expanded window showing the complete history
of selections in the current SiteView session.  The current 
selection is at the bottom of the list, and earlier selections 
are shown in sequential order moving upward.  The 
Selection History window allows you too retrieve earlier 
selections, and to perform Boolean operations on those 
selections (i.e., on groups of objects).  Boolean operations 
are powerful aides in manipulating sets of objects because 
they allow you to combine and compare groups of objects, 
and allow you to subselect only the set you want to deal 
with.

Manipulating Groups of Objects

The Boolean operations that you can execute from the 
Selection HistoryÉ window are,

¥ UnionÑcombining two groups into an aggregate which 
includes all of the objects in either or both of the groups;

¥ IntersectionÑfinding the set of objects which are 
common to two groups (i.e., the overlap); and 

¥ DifferenceÑfinding the set of objects which are in one 
group but not in another.

Finding the Union of Two Groups

You can combine the contents of two groups into one group 
using the Union function from the Selection HistoryÉ 
window.  The following example shows the union of two 
groups of objects.
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First Element: Second Element:
group (4)* *Sample (4)*
*Boring B-1* *SampleSO-3*
*Boring B-2* *SampleSO-4*
*Boring B-3* *SampleSO-5*
*SampleSO-3* *SampleSO-6*

First Element:
*Group (8)*
*Boring B-1*
*Boring B-2*
*Boring B-3*
*SampleSO-3*
*SampleSO-4*
*SampleSO-5*
*SampleSO-6*

Finding the Intersection of Two Groups

You can find the objects that are common to two groups and
place them as a single object or group using the 
Intersection function from the Selection HistoryÉ window.  
The following example shows the intersection of two groups
of objects.

First Element: Second Element:
*Group (4)* *Sample: Soil (4)*
*Boring B-1* *SampleSO-3*
*Boring B-2* *SampleSO-4*
*Boring B-3* *SampleSO-5*
*SampleSO-3* *SampleSO-6*

First Element:
*SampleSO-3*

Finding the Difference between Two Groups

You can subtract the objects in the first group from those in
the second using the Difference function from the Main 
keypad.  The following example shows the difference 
between two groups of objects.

First Element: Second Element:
*Group (4)* *Sample: Soil (4)*
*Boring B-1* *Sample SO-3*
*Boring B-2* *Sample SO-4*
*Boring B-3* *Sample SO-5*
*Sample SO-3* *Sample SO-6*



Chapter 5:  Selecting objects

First Element:
*Sample: Soil(3)*
*Sample SO-4*
*Sample SO-5*
*Sample SO-6*

Separating the Contents of an Group

You can separate the objects that make up the group by 
selecting the group of objects, and then from the Edit menu
choosing SelectÉ.  In the Choose From window elect From 
Selection, and click on the object class(es) in the left hand 
list.  The group of individual objects constituting the 
selection is show in the right hand list.

Manipulating the Selection History

The Selection HistoryÉ window allows you to

¥ change the order of selection elements,
¥ move elements from to the beginning of the stack,
¥ duplicate stack elements, and

You can change the stack positions of elements easily.  To 
move an element to the first stack position, display the 
element in the Selection HistoryÉ scrolling list and click on 
it.  The selected element is moved to the first position; the 
first element is moved to the second position; the second 
element to the third position, and so on.

Find related

For any group of objects that you highlight in the scrolling 
lists of the Select... window, you can find all the related 
sources, samples, and measurements.  The group for which 
you find related objects can be all of the same object type, 
or can be a mixed group.

You can find the objects related to a group in the 
Selection... window, by using the "Find Related" option in 
the Selection History... window.  Highlight in the scrolling 
lists the group of objects for which you want to find related 
objects.  In the Find Related pull-down window choose the 
class of related object you want to find.  Click on the Apply 
button to find the related objects.

For example, in the last section you found all the TCE 
measurements with values greater than 100.  To find the 
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borings those measurements came from, leave those TCE 
measurements highlighted in the scrolling lists, and choose 
"borings" in the Find Related window.  Click on Apply and 
the related borings are selected.  To find, in turn, all the 
samples related to these boringsÑwhether of TCE or 
notÑchoose "samples" in the Find Related window and click
on Apply.

Store/recall selection
When you use a group, object, or value often, you can store 
it in a register to use again.  Registers are stored stack 
elements.  Using the Store/Recall SelectionÉ. window, you 
can perform the following operations:

¥ store objects or groups in registers you define on-the-fly,
¥ recall objects or groups from registers, and
¥ delete a specific stored register.

To open the Store/Recall Selection window, choose the 
Store/Recall...  command from the Edit menu.

To store stack elements in a register, type the name with 
which you would like to store the first stack element in the 
Name text line and click the Store button.  To recall stored 
registers, choose the register name to recall by clicking it 
in the scrolling list or typing it in the Name text line and 
click the Recall button.  

To delete a specific register, choose the register name by 
clicking it in the scrolling list or typing it in the Name text 
line and click the Delete button.  
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Chapter 6

Potatoes in space (iso-shells)

SiteView allows you to create and visualize iso-shells of three-
dimensional continuous and discrete fields.  At ConSolve, we 
jokingly call these things, “Potatoes in space,” because that’s 
what they look like.  Some other people call them “Onions” or 
“Blobs.”  More prosaic people call them “iso-shells” or “iso-
surfaces.”  You can call them whatever makes you happiest.

A 3D field is a spatial distribution of an attribute or attributes 
which has a value at every xyz point with some spatial domain 
of interest.  For example, the concentration of TCE within the 
3D subsurface underlying a site is a fields.  So is the NOx 
concentration in the air above the site.  Every point in the 
domain has a concentration value associated with it, although 
many of these may be zero.  An iso-shell of this TCE field is the
locus of xyz points at which the concentration of TCE equals 
some fixed value, for example, 100 ppb.  

An iso-shell is the 3D analog of an iso-line (i.e., contour) on an 
xy-attribute surface in two-dimensions.  Just as contour lines 
can be set at any value, iso-shells can be set at any value.  
SiteView calls this value an "iso-value."  Just as contours form 
a nested set of closed loops on a 2D map, iso-shells form a 
nested set of closed boundaries in a 3D visualization.  These 
nested boundaries appear much like the layers of an onion.

Using SiteView, you can start from a set of arbitrarily located 
measurements points, interpolate a 3D grid of points within an
attribute field, and then generate iso-shells of that field at any 
iso-value.  You can slice these iso-shells along planes parallel 
to your axes, and visualize the results in many ways.

This Chapter discusses the following topics:

¥ SiteView's algorithms for creating iso-shells
¥ How you can create iso-shells
¥ Iso-shell selection properties.
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Iso-shell Modeling
SiteView creates an iso-shell by starting with a set of attribute 
measurements located in three-dimensional space.  These 
measurements need not be regularly positioned in xyz.  Form 
this set of measurements, SiteView creates a 3D grid and 
interpolates values of the attribute at all of the grid points, 
using a set of measurements.  Once the gridded values are 
obtained, SiteView interpolates linearly within each grid cell to
fit small planar facets of constant attribute value those data.  
These small planar facets are connected to build an iso-shell.  
You can choose the way these shells are visualized by 
changing their iso-values, there colors, the way light shines on 
and is reflected from them, where they are sliced, whether 
they are made to look solid, and in many other ways.

Data Requirements

To create an iso-shell, SiteView requires a group of attribute 
measurements located in xyz space.  As with any interpolation 
scheme, there is no minimum number of required 
measurements, but the more measurements you have, the 
more accurately the interpolation will reflect site conditions.  
Typical attributes you may want to interpolate could include,

¥ Total volatile organics in soil and groundwater,
¥ Mercury concentration in lake waters, or 
¥ NOx concentration in the air.

Gridding

When you import objects and attribute data into SiteView, they
are usually positioned irregularly in space.  To regularize the 
data, SiteView creates a spatial grid of attribute values from 
the irregular points.  A grid is a 3D regularly spaced lattice of 
points.  SiteView creates a uniform grid parallel to the axes of 
the site.  This grid has the same spacing between points in 
each principal direction. 

Grid spacing

The default grid generated automatically when you create a 
new iso-shell has ten (10) grid points in the largest dimension, 
or 1000 or fewer in total.  Depending on the complexity of your
data, more grid points may be required to provide a realistic 
representation of your data.  You can change the number of 
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grid points by adjusting the MaxGridDimension option in the 
Selection Properties window.

Grid location

It is sometimes convenient to move the principal axes of the 
grid used to interpolate data to a different region of the site.  
You can change the location of the window that the grid uses 
to interpolate within to create iso-shells by using the move tool
on the view tool pallet.  To move the grid, first orient the 
viewpoint from which you are looking at the iso-shell to be 
perpendicular to the plane in which you want the movement to
occur.  Select the iso-shell, and click on the Move pallet tool.  
You can move the iso-shell grid by dragging the mouse.  When 
you release the mouse, the grid will be relocated, and the iso-
shell will be reinterpolated.

Interpolation

SiteView interpolates attribute data for iso-shells using a 
gravity weighted sum approach.  For the sparse data sets 
typical of most environmental visualization problems, gravity 
weighting is generally thought to provide interpolations 
reasonably similar to other weighted sum algorithms, 
including Kriging.  Gravity interpolation is reasonably fast and 
does not require user intervention in estimating complex 
model coefficients.  

Formulas

All weighted sum interpolation algorithms are based on an 
equation of the form:

n
zo = S wi zi such that, 0 £ wi £ 1

i=1

in which zo is the interpolated value of the attribute at some 
grid point, wi is a set of weights corresponding to each of the 
i=1, ..., n measured attribute values, and zi is the set of 
measured values.  SiteView uses all of the measurement points
for interpolation.

SiteView's gravity interpolation model assigns weights to the 
measured values in proportion to the inverse of the square of 
the distance between the measurement location in 3D and the 
location of the grid point to be interpolated.  That is,
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wi  = constant/(distance)2

in which distance is the three-dimensional distance between 
the interpolated grid point zo and the measurement point zi, 
and the constant normalizes the sum of weights to be 1.0.

Anisotropy

When SiteView creates a new iso-shell it defaults to isotropic 
weights.  That is, the weight assigned to a measurement in 
interpolating a grid point depends on the distance from the 
measurement to the grid point but not on the direction of the 
distance.

You can add vertical anisotropy to the interpolation by 
adjusting the Anisotropy factor in the Selection Properties 
window.  Factors greater than zero increase the influence of 
measurements in the horizontal direction and decrease the 
influence of measurements in the vertical direction.  Factors 
less than zero increase the influence of measurements in the 
vertical direction and decrease the influence of measurements 
in the horizontal direction.  Setting the anisotropy factor to the
value k changes the directional influences by an amount 
proportional to 2k.

Iso-shell construction

Once SiteView has created a 3D grid of interpolated attribute 
values, it sequentially looks at each grid cell and finds those 
whose vertex attribute values bound the current iso-value in 
the Selection Preferences window.  These are the grid cells 
through which the iso-shell passes.

In each of these grid cells, SiteView linearly interpolates 
between the grid points and calculates triangular surface 
patches of constant iso-value.  Several such triangular patches
may be required in a single grid cell.  The group of all such 
surface patches throughout the gridded domain is connected 
together into a continuous surface to create the iso-shell.  You 
can see these surface patches by choosing Edges Visible with 
the Selection Properties window.

When you visualize a shell in a 3D view, you can make the 
shell appear either solid or hollow.  When you slice a solid 
shell, the plane of the slice shows a continuous interpolation of
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attribute value, as if you were slicing a solid object which was 
colored according to attribute value.  

When you slice a hollow shell, the shell appears as a manifold 
with an empty inside.  To see multiple hollow shells at 
different iso-values, create as many shells as you wish with the
same attribute data set, and them give each iso-shell the same 
Selection Properties, but with different iso-values.  

Note:  The time it takes your computer to paint the screen 
depends on the number of polygons that it has to render.  
Adding multiple iso-shells multiplies this number of polygons 
and causes the computer to take longer to paint a view.

Creating iso-shells
An iso-shell is created in SiteView using a four step process:

1. Import the objects and attribute data you want to use to 
create an iso-shell.

2. Select those objects whose attributes you want to create a 
shell form.

3. Tell SiteView to create an iso-shell from the selected groups
of objects.

4. Use the Selection Properties window to adjust the visual 
properties of the iso-shell as desired.

Import data

SiteView can create iso-shells from any attribute data.  These 
data are imported into SiteView using normal spreadsheet 
import.  They can be imported either as attributes associated 
with samples or other objects, or as plain value points.  A 
value point is a measurement that has only (x,y,z,value) 
information.

Select group of objects

To create an iso-shell, first you must select the group of 
objects whose attributes you want to use to create the iso-
shell.  You can select these objects by clicking on them with 
the mouse, or by using the Select command from the View 
menu.  At this stage you need only select the objects you are 
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interested in; SiteView will later ask you what attributes you 
want to use.

Create iso-shell

Once you have the objects of interest selected, from the Edit 
menu choose Create and pull-right to see the sub-menu of 
derived objects that you can create.  Choose Iso-shell.

When you choose Iso-shell from the Create sub-menu, a dialog 
box appears which shows a scrolling list of all the attributes 
associated with the current selection of objects.  From this list,
click on the attribute of which you want to create an iso-shell.  
Then click on OK.  SiteView creates an iso-shell of the 
attribute data using a set of default properties which you can 
later adjust to suit your tastes.

Adjust properties

When SiteView creates an iso-shell it uses a set of default 
parameters for grid size, color ramp, anisotropy, and other 
properties.  Usually, you will want to adjust at least some of 
these properties to obtain the visualization that you think best 
reflects true field conditions.  You should pay particular 
attention to grid size and anisotropy as these can have 
important influence on your final result.

Note:  When adjusting Selection Properties, it is always a 
good idea to put your view in Quick mode.  Rendering a 
complex visualization with many features on a PC takes time.  
Drawing a wire frame figure is much quicker.  Therefore, 
make all the changes you want with the view in quick mode, 
and then when you want to see a fully rendered version, 
switch to normal mode.

Iso-shell properties

Shell model

This section discusses those Selection Properties which 
pertain to the way SiteView constructs its mathematical model
of a 3D field for constructing iso-shells.
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Iso-Value

The iso-value is the value of the 3D attribute field at which you
want to visualize the iso-shell.  The iso-value is analogous to 
contour value in an xy-attribute surface model.

Max grid dimension

The maximum grid dimension is the maximum number of grid 
intervals in any principal direction.  SiteView sets the number 
of grid intervals in the longest principal direction to equal this 
number and adjusts the number of grid intervals in the other 
two principal directions accordingly.  The amount of time it 
takes SiteView to numerically interpolate a grid is proportional
to the cube of the grid dimension.

Anisotropy factor

In the natural world many processes are inherently 
anisotropic.  That is, their extent or behavior in one principal 
direction, say one axis in the horizontal plane, is different from
their behavior in other directions.  This difference is captured 
by anisotropy in the way SiteView interpolates attribute values
on a grid.  SiteView accommodates anisotropy between the 
horizontal plane and the vertical axis using an anisotropy 
factor.  For no anisotropy (i.e., isotropic interpolation) 
SiteView sets this factor to zero (0).  Positive values of the 
anisotropy factor give increasing importance to horizontal 
neighbors; negative factors give increasing importance to 
vertical neighbors.

Solid value below

An iso-shell divides space into two (not necessarily continuous)
regions:  that region in which attribute values are greater than
the iso-value, and that region in which attribute values are less
than the iso-value.  Toggling-on Solid Value Below causes 
SiteView to display the region in which the attribute values are
less than the iso-value.  Toggling-off Solid Value Below causes 
SiteView to display the region in which the attribute values are
greater than the iso-value.  

Min/Max Planes

The minimum and maximum planes in each of the x, y, and z 
directions set the bounds within which SiteView displays an 
iso-shell.  These can be thought of a cutting planes
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Min/Max Caps

You can make the shell appear either solid or hollow.  When 
you slice a solid shell, the plane of the slice shows a 
continuous interpolation of attribute value, as if you were 
slicing a solid object which was colored according to attribute 
value.  Toggling-on the minimum or maximum cap causes the 
corresponding cutting plane to show a solid interpolation of 
attribute value as if the shell were a solid body.  Toggling-off 
causes the corresponding cutting plane to be transparent so 
the shell appears hollow.

Visualization

This section discusses those Selection Properties of iso-shells 
which pertain to the way iso-shells can be visualized

Hidden

Toggling-on Hidden causes the iso-shell not to be seen in the 
view.  Toggling-off causes the iso-shell to show.

Color-Shading

The various Color-Shading options allow you to change the 
way the iso-shell coloring is graded to reflect attribute value.

Color   Map  

The Color Map chooser allows you to select one of four color 
ramps:  Standard, gray, rainbow, and cyan/yellow.  Standard is
a continuous ramp (purple to yellow) which many people find a
pleasing and visually compelling gradation for visualizing 
contaminant distributions.  Gray is a continuous gradation 
(white to black) through the gray tones.  Rainbow is a banded 
ramp of six colors (royal blue, cyan, green, yellow, orange, 
red) which can be used to show step-wise gradations of 
attribute value.  Cyan-to-Yellow is a two band ramp.

Color   interpolation  

The Color Interpolation option allows you to smooth any of the 
color maps.  For example, choosing color interpolation with 
the Cyan-to-Yellow color map yields a smooth transition of 
colors between cyan and yellow.

Color   shading auto  
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Color Shading Auto automatically adjusts the minimum and 
maximum values of a color ramp to be the same as the 
minimum and maximum attribute values in the attribute field.  
Toggling-off Color Shading Auto causes SiteView to look for 
the values in the Color Shading Min and Color Shading Max 
options.

Color   shading min and max  

Color Shading Min and Color Shading Max allow you to fix the 
minimum and maximum attribute values for the color map in 
the case where Color Shading Auto is turned off.  You can set 
the minimum and maximum to have any value you want.  This 
provides flexibility to choose exactly which parts of the chosen 
color ramp you want to use to visualize an iso-shell.  SiteView 
will uniformly grade the color ramp over the interval between 
the minimum and maximum color shading values.

Color   shading factor  

The color shading factor provides a way of compressing or 
expanding intervals of the color map.

Index Interpolation  

Index Interpolation is a toggle which allows you to choose 
between color interpolations of an attribute field according to 
the color map as opposed to a constant coloring of the faces of
the iso-shell.  When Index Interpolation is turned on, SiteView 
uses the color map to visualize a shell.  When Index 
Interpolation is turned off, SiteView colors the shell according 
to the selection under Face Color.  Turning Index Interpolation
off, and setting the face color to white, allows you to 
experiment with light colors and reflectivity.

Color legend visible

The Color Legend Visible option allows you to place an 
automatic color legend on any view.  The legend shows 
whatever color map is chosen, the range of attribute values, 
and smoothes the color map is Color Interpolation is turned 
on.  The legend can be moved or scaled using the pallet tools.  
To bring the legend back to its original position and shape, 
used Reset Position from the Edit menu.
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Faces, edges, and lines

This section discusses those Selection Properties of iso-shells 
which pertain to the ways faces, edges, and lines of shells can 
be visualized.

Color

The color option provides a color chooser from which you can 
set the color of the faces, edges, and lines of an iso-shell.  The 
color choose provides 30 assorted colors.  At the bottom you 
can choose a custom pallet of colors.  Custom colors can also 
be added to the standard list from the pallet.

Visible

The Visible toggle allows you to hide or show faces, edges, and
lines.

Width

The Width toggle allows you to change the width of faces, 
edges, and lines.  The default is one (1).  Higher integers 
increase edge or line width.

Perimeter edges only

Each surface patch in an iso-shell has an edge and face color.  
Toggling-on Perimeter Edges Only causes the edges of all the 
faces except those on the perimeter of the iso-shell to be 
hidden.  Toggling-off Perimeter Edges Only causes the faces of
all the edges to be visible.
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Chapter 7

Surfaces 

Surfaces provide an easy means of visualizing large 
quantities of data; they show the values of attributes as 
they change based on their location.  SiteView allows you to
create surfaces in 3D views.  Surfaces show the values of 
attributes as they change with x,y location.  They provide 
an easy means of visualizing large quantities of data and of 
estimating values at points where no value is known.  This 
chapter describes the methods by which SiteView creates 
surfaces.  

Surface Modeling
The following sections describe how (x,y, attribute)-
surfaces are generated.  Three steps are necessary to 
create surfaces:
1. You specify a group of data points or samples (by 

selecting it) and a dependent variable (in a dialog box).  
2. SiteView triangulates the corresponding x,y location 

data.
3. SiteView creates a continuous surface by piecing 

together the triangles.
4. To smooth the surface, SiteView interpolates values of 

the surface on a regular grid, and then contours the 
interpolated values. 

Data Requirements

To create a plan surface, SiteView requires an group of 
objects that have both location and attribute data.  Location
data are x- and y-coordinates that indicate the objectsÕ 
placement in the xy plane.

Attribute data are the dependent variable values, the data 
that youÕd like to visualize.  These data correspond to 
object attribute values that are numeric, or NS (not 
specified).  Some examples of attributes that contain 
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attribute data include:  z (the elevation or depth of an 
object), total volatile organics, and the concentration of 
cadmium.

Triangulation

After SiteView verifies that its data requirements are met, it
creates a triangulated irregular network (TIN) of the 
location data using the Delaunay triangulation method.  
That is, SiteView creates nearly-equilateral triangles whose
vertices are the location points, such that the 
circumscribing circle of each triangle contains no other 
points.  Triangles form the basis for the interpolation of 
attribute data unless the surface is smoothed.

Interpolation

To create a smooth surface, SiteView interpolates attribute 
data among the points at which the attributes are known.  It
does this using Natural Neighbor interpolation.  Surfaces 
are created using Natural Neighbor interpolation on the 
grid spacing that the user specifies, and then contour lines 
linearly interpolated on the surfaces.

Surface display properties
You can select surfaces by clicking on them or using the 
SelectÉ  dialog box.  When a surface is selected, SiteView 
displays a polygon surrounding the surface (i.e., the convex 
hull of the surface defining points).

After surfaces are created and selected, you can change 
their appearance.  SiteView supports the following surface 
display properties: 
 contours are lines along which the dependent values of 

the surface are equal.
 color-shading helps you visualize the dependent values 

of a surface by mapping ranges of values to colors and 
coloring the surface accordingly.

The following sections describe the options you can set in 
the Selection PropertiesÉ. dialog box when displaying 
surfaces.  You can choose more than one style for a surface.
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Hidden

Hidden is an on/off setting which shows or hides the 
surface in its entirety.

Contours

You can arbitrarily set a number of visualizations for 
contours.  These are each separate options within the 
Selection PropertiesÉ. dialog box.

Contours visible

On/off toggle to make the contours visible in the view.

Contour color

Provides a color chooser from which to select a color for 
the contours.

Contour linear spacing

Toggles between linear and logarithmic spacing for the 
contours.  Linear calculates contour lines for the base value
and any value differing from the base value by a multiple of 
the interval.  For example, if you specify 0 for the Base 
Value and 5 for the Interval, the first value in the series is 
0; the adjacent contours are 5 and -5.  Subsequent contours
are 10 and -10, 15 and -15, and so on.

Logarithmic calculates contour lines for the base value and 
any value that equals the base value multiplied by an 
integer power of the factor.  For example, if you specify 1 
for the Base Value and 2 for the Factor, the base contour in
the series is 1; the adjacent contours are 2 (21) and 0.5 (2-
1).  Subsequent contours are 4 (22) and 0.25 (2-2), 8 (23) 
and 0.125 (2-3), and so on.

Contour base

Sets the base attribute value from which contour spacings 
are calculated.

Contour interval

Sets the numerical interval between contour values.
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Contour below base

Yes/no toggle to hide or display contour lines whose values 
are below the base value.

Smooth

Yes/no toggle allowing you to choose smooth or angular 
contours.  If you choose Yes for smooth contours, SiteView 
connects the points on the interpolated grid to construct 
contours.  If you choose No, SiteView uses the Delaunay 
triangulation to construct contours.  

Contour emphasis

Yes/no toggle allowing you to emphasize certain contours.  
Choose Yes, indicate how frequently to color, and choose 
the emphasis color.  

Contour emphasis every  

Lets you set the frequency of highlighting contours.  To 
emphasize every fifth contour, enter 5 in the field and press
on return.

Contour emphasis color  

Provides a color pallet for selecting the color of the 
emphasized contour.

Contour emphasis width  

Lets you set the line width of the emphasized contours.  A 
line width of one (1) is default.

Text

The text options refer to contour labels, their color, 
frequency, position, and so on.

Text visible

Allows you to choose to label values for all, none, or only 
color-emphasized contours.  
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Text color

Provides a color pallet for changing the color of the contour
labels.

Contour label placement

Choose where the labels are placed (right, lower-right, 
bottom, lower-left, left) for each labeled contour.  Click pull-
down list to choose the location.  

Contour label frequency

Allows you to set the spacing of the contour labels.

Cells

Every surface is made up of both of triangular cells which 
are defined by the Delaunay triangulation of the data points
and of grid cells that are generated by SiteView when 
smoothing a surface.  Normally, these cells are not visible 
in the 3D views, but are part of the underlying mathematics
of the surface model.  Using the Cell properties you can 
make the cells visible and change the way they look.

Cells visible

This is a yes/no toggle which makes the cell boundaries 
visible or invisible.

Face color

Provides a color chooser with which to select the color cell 
faces.

Cell color

Provides a color pallet with which to color the cell lines.

Cell index interpolation

Yes/no toggle that turns of and off the attribute-driven color
shading of the cell lines. 

Cell quads only

Yes/no toggle that shows only the square cell elements 
making up the surface (i.e., hides the diagonal segments).  
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Quad-cells-only often provides a more visually appealing 
surface net than the full triangles do.  This property is only 
applicable to smooth surfaces.

Color-Shading

The color shading options allow you to color a surface with 
a gradient or color ramp, where the color of the surface at 
any point corresponds to the interpolated attribute value at 
that point.  For presentation purposes, you may also place a
color legend on any view, which shows the scale of the 
attribute vs. color.

Color map

Note that you can choose among four color ramps for color 
shaded surfaces.  These are found under the ÒColor MapÓ 
property.  The four choices are:

¥ StandardÑSmooth ramp, dark blue through red to 
yellow.

¥ GrayÑSmooth ramp, dark through light gray,
¥ RainbowÑBanded ramp from ... through ...
¥ Cyan to YellowÑStepped ramp, cyan-yellow 

Color interpolation

Turning color interpolation on sometimes creates a much 
smoother gradation of colors on a surface, but also 
increases the rendering time.

Color shading automatic

This is a yes/no toggle which sets the scale of the attribute 
surface to run from the minimum attribute value in the data
set to the maximum attribute value in the data set.  If you 
turn Color Shading Automatic off, then the surface scale is 
set to run between the Color Shading Minimum and Color 
Shading Maximum (below).

Color shading minimum/maximum

These two properties allow you to specify the minimum and 
maximum values for the color shading.  For example, using 
the standard color ramp, minimum values are drawn in 
deep purple, maximum in yellow.  Dramatic effects can 
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sometimes be obtained by altering minimum and maximum 
values.

Color shading factor

The color shading factor is a number between centered on 
zero that allows you to exaggerate or compress the color 
ramp.  At zero, the color ramp is the default gradient of 
colors.  As the color shading factor becomes larger, the 
color ramp is shifted toward higher colors; as the color 
shading factor becomes smaller, the color ramp is shifted 
toward lighter colors.

Color shading index interpolation

Yes/no toggle that turns on and off the color shading ramp 
on the surface.  Turning index interpolation off makes the 
surface all the same face color.

Legend

Check the Show Color Legend box if you want the view to 
include a legend for the surface's color ramp.  As you make 
changes in the surface color ramp, the legend automatically
updates to reflect them.

Z from attribute 

An x,y-attribute surface forms a mathematical model for the
attribute value over space and colors the surface 
corresponding to the attribute value.  The spatial location 
or elevation of the surface, however, corresponds to the 
elevation values (z-values) of the objects used to form the 
surface.  Z-from-attribute causes the surface elevation to 
follow the attribute value, normalized to appear within the 
bounding box of the surface.
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Chapter 8

Stratigraphy

This chapter describes how to import geologic information 
and build stratigraphic representations in SiteView

Stratigraphic Modeling
SiteView displays site stratigraphy as stratigraphic panels 
in both 3D and Profile views using data from the boringsÕ 
stratigraphic samples.  Stratigraphy can also be depicted 
using colored solid models (iso-shells) in 3D views.

In 3D views, stratigraphic panels have a three-dimensional, 
oblique projections, and thus behave as fence diagrams.  
Iso-shell solid modeling can also be used in 3D views to give
a more visually compelling, if slightly less accurate, 
depiction of stratigraphy.

Importing and viewing 
stratigraphic information

SiteView represents stratigraphic information in borings, 
monitoring wells, or other downhole observations as a set 
of from-to samples of material type.  To import stratigraphic
samples, you should first enter the source, from-value, to-
value, and material type in rows or columns of a 
spreadsheet.  You may also name each stratigraphic sample
if you wish.  Save the information as a .tsv file, and open the
file in SiteView by choosing the Import SpreadsheetÉ.  
command from the File menu.

The stratigraphy samples are represented by from-to boxes 
along the borings from which they come.  These 
representations have edges, the color and thickness of 
which can be varied, and faces the background color of 
which can be varied.  On the faces you can show stipple 
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patterns keyed to the material type represented by the 
stratigraphy sample.  

Stratigraphic Modeling
SiteView uses linear stratigraphic modeling to construct 
stratigraphic panels.  SiteView builds a stratigraphic model 
by matching stratigraphic samples that are of the same 
material and either are in borings that are adjacent in the 
section line, or are in non-adjacent borings but that are 
deeper than the bottoms of all intervening borings.

SiteView uses the following conventions when interpolating
stratigraphy in fence diagrams:

 For the stratigraphic modeling of two borings with the 
same sequence of materials, the top and bottom of each 
material are joined by straight lines.

 For the stratigraphic modeling of two borings when one 
boring contains a material that does not exist in the 
other boring, the material is pinched out half way 
between the borings.

 For the stratigraphic modeling of three or more borings 
when the two extreme borings are deeper than an 
interlying boring and have strata at deeper levels, these 
deeper strata are interpolated beneath the intervening 
borings.

 When two borings have materials that are not in the 
same sequence, SiteView interprets the materials as 
lenses, and pinches these out half way between the two 
borings.

 SiteView fills in concave regions beneath a shallow 
boring if the adjacent deep borings suggest this case.

 SiteView ends a stratum part way between two borings 
when there is no data to suggest how the stratum is 
resolved.

Fence diagrams in 3D views
In 3D views you can create a fence diagram by

¥ selecting the borings through which the fence diagram 
will run, and

¥ choosing Create Section Line from the Create... window 
of the Edit menu.
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This will create a fence diagram which interpolates the 
stratigraphy among the borings you have selected.  In the 
plan map a new section line is created, whose properties 
can be modified by using the Selection PropertiesÉ. 
window.

Selection properties
Stratigraphy samples and thus the fence diagrams they are 
part of have the following adjustable properties in the 
Selection PropertiesÉ. window.

Hidden

Yes/no toggle that hides or shows the stratigraphy sample.

Pixel width

Allows you to set the width of the stratigraphic sample 
bounding boxes

Edges

Edges visible

Yes/no toggle that shows or hides the edges of the 
stratigraphic sample bounding boxes.

Edge color

Provides a color chooser for the edge bounding box of the 
sample.

Edge width

Allows you to set the width of the edge line.

Faces

Faces visible

Yes/no toggle that shows or hides the flat faces of the 
stratigraphic sample bounding boxes.
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Face color

Provides a color chooser for the background color of the 
face of the stratigraphy sample

Face pattern

Allows you to show or hide the stipple pattern for the 
stratigraphic sample.

Transparent

If face pattern is ON, then transparent makes the 
background invisible; if face pattern is not ON, then 
transparent has no affect.

Pattern color

Provides a color chooser for the stratigraphic stipple 
pattern.
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Chapter 9

Printing 

You can print any SiteView view to a color or monochrome 
printer that is supported by Windows, and you can save a 
view to file to be later incorporated in a report, slide 
presentation or some other application.

This chapter describes how to 

¥ print to a printer and 
¥ same to file.

Printing to a Windows supported 
printer

When you print a SiteView view, the printed image is 
identical to the one displayed on your screen.  To print a 
view to a printer:

1. Choose Page Setup... from the File menu.  The Page 
Setup dialog box appears.  Choose the margins you 
want.

2.  Choose Print... from the File menu.  The Print dialog box
appears.

3. Adjust the options in the Print dialog box as desired, and
click OK.

Printing to file
SiteView produces graphics files in a number of common 
formats when you use the Print to File command.  You can 
use the file with text processing or drawing applications 
that can import encapsulated PostScript files, to save 
specific figures that might appear in reports or 
presentations, or to create a file to be passed to other 
computers or users.



Chapter 9:  Printing 

To create a graphics file of a view, under the File menu 
choose Print to File... , and specify the file path and 
graphics format you want in the dialog box.  The Print to 
file option supports the following graphics formats:  

 Postscript, 
 Encapsulated Postscript, 
 CGM, 
 HPGL, and 
 PICT.
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SiteView Classes and Attributes

SiteView provides an object dictionary that contains the 
definitions of the classes discussed in this chapter.  This 
Chapter describes 

¥ SiteView classes and attributes, and
¥ descriptions of SiteView data types.

SiteView supports the following default object classes--in 
addition to the iso-shell, surface, and section line derived 
classes--for handling environmental data.

Annotation
Annotations are created using the Annotation tool  The 
following table lists the Annotation classÕ attributes.

Attribute Type/Description
Name String.  

Boring
Boring is based on the Proto Boring class.  SiteView allows 
you to create Fence Diagrams from Boring class objects.  
The following table lists the Boring classÕ attributes.

Attribute Type/Description
Name String.  
X Distance.
Y Distance.
Z Distance.
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DXF layer
Layers are created when importing or exporting DXF files.  
The following table lists the Layer classÕ attributes.  

Attribute Type/Description
Name String.  Each object can have a name.
Source File String.   The DXF file from which the layer 

comes.
Name in File String.  The name of the layer in the DXF 

file.

Monitoring Well
Monitoring Well is based on the Boring class.  SiteView 
allows you to create Fence Diagrams from Monitoring Well 
class objects.  The following table lists the Monitoring Well 
classÕ attributes.

Attribute Type/Description
Name String.  
X Distance.
Y Distance.
Z Distance.

Sample
The following table lists the Sample classÕ attributes.  

Attribute Type/Description
Name String.  Each object can have a name.
Source Reference to source object.
X Distance.
Y Distance.
Z Distance.

Measurement
The following table lists the Measurement classÕ 
attributes.  Parametric attributes are noted with  ; they are 
attributes whose values are derived by SiteView rather than
specified by you.

Attribute Type/Description
Name String.  Each object can have a name.
Source Reference to source object.
Attribute String.
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Value Float in point number.

Stratigraphy Sample
The following table lists the Stratigraphy Sample class 
attributes.  Parametric attributes are noted with  ; they are 
attributes whose values are derived by SiteView rather than
specified by you.

Attribute Type/Description
Name String.  Each object can have a name.
Source Reference to source object.
From Distance.
To Distance.
 X Distance.  The stratigraphic sampleÕs x-

coordinate is taken from its source.
 Y Distance.  The stratigraphic samples y-

coordinate is taken from its source.
 Z-From Distance.  Z-From is calculated by 

subtracting the stratigraphic sampleÕs 
From value from its sourceÕs z-coordinate.

 Z-To Distance.  Z-To is calculated by subtracting 
the stratigraphic sampleÕs To value from 
its sourceÕs 
z-coordinate.

Attribute/
Material

Type/Description

The stratigraphic materials list, for which SiteView associates 
distinct stipple patterns, includes:
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Soil Categories Rock/Engineering Geology
Types

SC Clayey sand
SM Silty sand
SP Poorly graded sand
SW Well graded sand
GC Clayey gravel
GM Silty gravel
GP Poorly graded gravel
GW Well graded gravel
MH Inorganic silt of high 
plasticity
ML Inorganic silt of low 
plasticity
CH Inorganic clay of high 
plasticity
CL Inorganic clay of low 
plasticity
OH Organic clay of high 
plasticity
OL Organic clay of low 
plasticity
PT Peat, muck

Andesite
Anthracite 
Basalt
Breccia
Chalk
Clay
Coal
Conglomerate
Crystalline 
Rock
Diorite
Dirty Sand
Dolomite
Evaporite
Felsite
Gabbro
Gneiss
Granite
Gravel
Greenstone

Hornfels
Lignite
Limestone
Marble
Peat 
Porphyrite
Quartzite
Rhyolite 
Rock
Sand
Sandstone
Schist
Serpentine
Shale
Silt
Siltstone
Slate
Talc
Till

Value Point
Value Point is an independent Sample.  The following table 
lists the classÕ attributes.  

Attribute Type/Description
Name String.  Each object can have a name.
X Distance.
Y Distance.
Z Distance.
Sampled 
Value

Attribute Value

Water Level
The following table lists the Water Level classÕ attributes.  

Attribute Type/Description
Name String.  Each object can have a name.
Source Reference to source object.
X Distance.
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Y Distance.
Z Distance.
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